
The Magic Doors Launcher Template

Have you ever watched a movie trailer to 
decide if you want to watch a movie? 
How about flipping through two books to 
decide which one to buy? Everyone likes 
to have a sneak peek before making a 
choice. This template does just that, 
letting students see a preview image and 
hear a related sound before deciding 
which activity to do next.

The three versions of this template 
create an animated launcher for two, three, or four activities. Depending 
on which version is in use, a student is presented with a scene of two, 
three, or four closed and locked doors in a wall. Clicking on a keyhole gives 
the user a preview of the activity, as if they had peeked through the 
keyhole to see what is inside. Dragging the key to a keyhole opens the door 
and launches the activity. 

It isn't really magic! There is both a transparent button and a region on 
each keyhole, one atop the other. Clicking the button presents a preview by 
running a short animation of the keyhole getting closer, then showing a 
picture from the activity and playing a sound from it. Moving the key to the 
keyhole activates the region, which in turn activates a hidden button to 
open an activity or other file. 

Finished Sample Step By Step Instructions Possibilities

Backstage Tour Tips And Tricks Troubleshooting



Explore The Finished Sample
If you haven't already, get IntelliTools Classroom Suite® running, and install 
the Magic Doors zip file.  Then open MagicDoorsSample to try out a 
finished version of the template. I have set up the sample with two typical 
activities linked to the doors. Click the two keyholes to look at the previews. 
Drag the key to either door's keyhole, and one of the activities will open. 
Close the activity, and drag to key to the other door to open the second 
activity. Then follow the instructions to learn to set up the Magic Doors 
Launcher Template.    

Overview Of Using The Template
Here's all you have to do to set up the Magic Doors Launcher for your 
students: Choose a background image from a toolbar, insert a picture for 
each preview that relates to the file that will open, import or record a sound 
to go with the preview image, and designate the target file for each door. So 
what you need to provide are:

 A  preview image for each activity you plan to link to this launcher, 
probably screenshots.
 A sound for each linked activity, either from the Media Library, 
recorded, or from a source such as freesound.org
 Most important, get together the activity choices you want to offer 
to your students.
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Quick Trick: Open both the launcher template and the files you intend to 
link to the launcher. You can find and copy preview images and sounds 
from your files and, via the Window menu, move them into the launcher. 

Another Tip: It's best to move the activities you intend to link all to one 
folder before linking them to the launcher. Not only does this help keep 
everything together, but that way a student sees the launcher right away 
and does not have to guess which is the starting file. 
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Magic Doors Launcher Step By Step
1.   Pick a style for the doors by inserting one of the backgrounds from the 
toolbar at the top of the screen. In each version of the template I have 
included a door style that looks like it might be in a creepy dungeon, a fancy 
one, and one with primary colors.  

For the two door template there are two extra styles, red and green doors 
to match the typical switches.  Because some users may be in the habit of 
one or the other always being "Yes", I decided to have the red and green 
doors both on the left and right.  There also is a two door background using 
neither red nor green.

Type the title of the linked activities into the text boxes above the doors. 
You may want to adjust the positions of the title text boxes or change the 
background or text color. Be sure to make them Read Only!  

If you prefer not to have text titles above the doors, perhaps to encourage 
students to guess what the story might be with the one image and sound for 
clues, delete those text boxes from the launcher template.  In that case, 
you'll need to also delete the same text boxes and their read out buttons 
from the overlay.
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2.   Preview Images: Click the purple buttons to jump into the animation at 
the correct timepoints and insert preview pictures for each door. The 
instructions you see are part of a floating picture, not in the background.  
Control-click on those instructions to open Picture Properties. Substitute 
your picture for the instructions you see in the keyhole frame by using the 
load picture icon under the Picture tab. You may need to adjust the size 
using the Vertical and Horizontal settings, and/or move the image a bit so it 
is centered through the close-up keyhole.  Once you are satisfied with the 
image, Lock the picture and set it not to respond to mouse, then click OK, 
and go on to the next purple button.    

CAUTION: Be sure you bring in the picture by a Control-click to open 
Picture Properties! If you used Insert Picture from the menu, it WOULD 
MESS UP THE ANIMATION. Copies of the picture would be inserted at all 
later timepoints. It's about the only way this template can go wrong.  

Take A Break and Save Your Work So Far!
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Quick Trick: Go to your open activity file via the Window menu, pick a 
page with a background you like, copy it in Page Properties, then go back 
to the template. Click a purple button to jump into the animation, 
control-click inside the keyhole frame to open Picture Properties, and 
paste your background from the clipboard.
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3.   Preview Sounds: Control-click each yellow button to open its Properties 
and import or record a sound under the Sound tab.  Don't change the names 
of these buttons!  The invisible buttons that run the preview animations 
refer to these button names.

Save Again Here.  It's More Fun Doing Everything Just Once!

4.   Linked Files: Control-click each blue button to add the links to 
activities. Under Actions, click Edit beside the Open File action. Navigate to 
and select the file you want to open to set the link, then click OK to close 
Properties.  Don't change the names of these buttons!  The buttons 
activated by putting the key into a region refer to these button names.

Quick Trick: You can export a sound used in your open activities, and 
import it as a preview sound. Go to your activity via the Window menu, 
and open Page Properties. Under the Sound tab you will see all the 
sounds used in that activity listed. Highlight the one you want, and 
Export it to the Desktop. Go back to the Magic Doors Template via 
Window, control-click a yellow button to open its Properties, and click 
the Sound tab. Import your exported sound and it will play during the 
preview for the door that connects to that activity.
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5.   Test out the launcher clicking the invisible keyhole buttons to see the 
previews, and dragging the key to each keyhole to open the files. During the 
previews you should see the keyhole expand as it gets closer and hear a 
sound effects as it does, then you should see your preview picture through 
the keyhole and hear the preview sound you chose.  When you drag the key 
to a keyhole, you will hear a door-open sound and then the file you linked to 
that door will open. 

 Quick Trick: You can add a button to a linked file to close it, or you could 
close it manually, and you will again see the Magic Doors Launcher with the 
key back in its place, ready for a student to choose again.  I've purposely 
NOT had the launcher close itself when it opens a linked activity. 

6.   Click the lighted Finish Up button to hide toolbars and save as activity.  
The Finish button hides all the construction toolbars so that students only 
interact with the text boxes, buttons on the keyholes, and the key.  

Special Access
Each version of this template has a custom IntelliKeys® overlay attached.  
The buttons on the keyholes in the template are invisible because they are 
set for Transparent, but I made visible versions for the overlays, marked to 
Take A Peek through the keyholes. The overlays also include buttons with 
the content of a set of buttons on a hidden toolbar (Hidden Stuff). 
Therefore you will see buttons on the overlays that read the main caption, 
read the signs above the doors, and move the key to each of the keyholes. 
Dynavox® versions of these three overlays are included with the materials 
you downloaded. 

Quick Trick: You can link to files other than ICS activities using this 
launcher. If the file will open by clicking on it, it should work! Of course, 
you must make certain the application that runs the file is there. Try 
linking a PDF  file. If you change the action from Open File to Open URL, 
you can open a web page...assuming you have an active web connection. 
How about linking to several YouTube movies?  
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For switch access, the signs above the doors, the main caption, the two 
invisible buttons on the keyholes, and the key are set to be part of a scan.  
Scanners can use directional arrows to move the key to a keyhole.  

The toolbars you used in customizing the template are not needed by 
students using the finished launcher, so those toolbars are hidden and 
removed from the scan list, and none of those buttons appear on the 
overlays.

Sharing The Launcher And Linked Sets Of Activities 
If you intend to share the launcher, it's best to move the finished launcher 
and its folder of linked files into an enclosing folder.  Then export that 
outer folder. ICS will export the launcher and all connected files, including 
movies, overlays, and linked files, to a single zip file.  When someone imports 
that zip file, the enclosing folder will disappear, and both the launcher and 
its folder of linked activities will be together wherever they were imported.  

Not So Quick Trick: More Possibilities 
You could also use this launcher as part of an adventure story. Start by 
deleting the instruction page, since you won't need that.  Add pages before 
the doors page that carry the story up to a branch point, then set up the 
Linked Files buttons to go to other pages instead of opening other files.  To 
do that, edit the actions in the Linked Files buttons. Remove Open File, and 
substitute Go to page (x).  You also could use a copy of the background of 
page (x) as the preview image, pasting it in behind the keyhole frame in the 
animation.  

Because the entire set of previews are in an IntelliMation® and a part of 
the page with the doors, you can add more pages without messing up any 
actions.  You also can add buttons to start the story over from your added 
pages, or to jump back to the decision point, without causing problems with 
the previews.  

Or, go ahead and link to separate ICS files, if you are building a long story 
with lots of multimedia. That may be the best solution, especially if you are 
working from a network. Just keep all the files in one folder, so that it won't 

©2016 ann brundige studio  www.annbrundigestudio.com
An IntelliTools Classroom Suite® lesson from Annie’s Resource Attic

Mar 15, 2016 6

http://www.annbrundigestudio.com
http://www.annbrundigestudio.com


matter where the entire set is moved.  This strategy means that you can't 
get back to the branch point without starting the story over again.  It's 
especially good for leading to different outcomes, from which a student 
might want to repeat reading the story and trying out the other choice(s).

What if you did a story or exercise that needed more than one branch 
point?  You can't transfer the preview animations to a new page but you CAN 
have one of your linked destinations be a copy of one of the three Magic 
Doors Launcher templates.  Just don't let your enthusiasm run away with 
you. The number of pages increases rapidly with branching stories!

Backstage Tour

This template makes use of several advanced techniques that not everyone 
knows exist in ICS.  Probably it's the only project you'll ever encounter that 
uses them all at once! But even one at a time, these techniques give you lots 
of extra options.  First, let's look at a diagram of the mostly hidden 
machinery behind one of the keyholes to understand how all these tricks 
work together.

The only parts that students interact with are located around the keyholes: 
the transparent Preview button, and a region on which to drop the key.  As 
you can see from the diagram, the Preview button has several actions, two of 
them selecting hidden buttons to play sounds.  

One of the hidden buttons, Keyhole Sound, has the action Play Sound (Do 
Not Wait) and is located on a toolbar you never see unless you look for it 
called Hidden Stuff. The other hidden button called from the transparent 
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Preview button is one of the yellow buttons into which you added sounds 
while setting up the launcher template, but it was hidden once you click 
Finish. The remaining actions of each of the invisible Preview buttons are to 
play a range of IntelliMation, pause to give the user time to look at the 
image you added and listen as your sound plays, and finally reset 
IntelliMation time back to 0, returning the user to the doors scene.  

The other half of the hidden machinery around the keyhole is a region.  It 
accepts the key as if it were a correct answer and activates another hidden 
button, one of the blue-green Linked File buttons you edited.  These also 
became hidden when you clicked Finish. The Linked File buttons play the 
sound of the door unlocking, move the key clip art back to its starting point 
(another region, Keydrop) , and open whatever file you designated.

Being able to call extra sets of actions stored in hidden toolbar buttons is a 
very powerful tool in ICS, one that not everyone knows about.  Two actions 
make it work: Select Button, and the option to have a region activate a 
button, either hidden or visible.  Now that you are aware of this option, 
you're all ready to use it, because the actions in these hidden buttons are 
the same ones you've always used.   

Take The Next Step
Now that you see how these advanced techniques work together in this 
particular template, let's look at them individually to see how you might use 
them to build new activities.  Maybe "advanced" is the wrong word to use for 
these, as most of them are easy, just things you hadn't tried before.
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Quick Tip: Remember that the Select Button action only can select 
toolbar, not Page buttons, but it CAN select buttons in hidden toolbars. 
Also, the Select Button action is identical to clicking the button, 
choosing it with a switch, or touching it on IntelliKeys: whatever actions 
are listed in the selected button will activate when it's selected.  
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1. Toolbar full of background choices for IntelliMation —This works by 
default, but be certain NOT to check Allow Multiple Backgrounds in the 
Document settings, if you want the same background throughout an 
animation.  Of course, you still can use a different background on different 
pages. In the Magic Doors Launcher,  the choice of backgrounds lets you 
change the entire look of the activity without affecting any of the 
animations.  There are no right or wrong choices in the Magic Doors, but you 
could use similar machinery to ask a question and let one of the doors lead to 
positive feedback, while the incorrect choices might add a clue and then, by 
returning to 0 seconds, let a student have another try.

Here is another idea for using choices for backgrounds, in which the student 
does the choosing.  Set up a writing activity for students, with an empty 
text box and a character moving across the page. You could use one of the 
frame animations—the eagle flying, a baby crawling, the boy or girl walking 
or in a wheelchair wheeling across.  The animations can be just two 
points,the first point at 0 seconds with the actor on one side of the page 
and the second, probably at 5 seconds, all the way across.  

Duplicate that page however many times you want, and add a Backgrounds 
toolbar, or maybe several, with a variety of backgrounds.  With the Page 
Action Hide All Custom Toolbars, followed by Show (toolbar for this 
page), it's easy to have the appropriate Backgrounds toolbar display on each 
page. Each button in those toolbars should have the action Insert As 
Background. 

Students can make up a story and write on each page about what the actor 
experiences.  It's easiest to let the animation run, then write at the end of 
the animation on each page. This could be a wildly creative exercise, 
depending on what background choices you supply.  Or, with a more focused 
set of background choices, the activity could be a review of a history or 
science lesson.  

2. Play Range Allows Multiple Animations on the same page. First thing to 
remember: REMOVE default page action, Play Animation And Page Sound, if 
you intend to use Play Range. Instead of using a page action that plays 
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automatically, you activate each animation segment from a button, either 
toolbar or Page Buttons.  

If you've never used Play Range, take a moment to see how it works.  The 
illustration shows the actions in one of the invisible Preview buttons that 
sits over one of the keyholes. Instead of the default, the IntelliMation 
action designates a range, Play IntelliMation And Page Sound, 6 to 8.  

Notice there is an active Edit button with this action. That's a clue that you 
have some advanced options available.  If the action you highlighted had no 
extra options, that Edit button would be grayed.  Click the Edit button, and 
look at the advanced options for IntelliMation.  The one we are using is Play 
Range, so there is a check in the box beside it.  Below that there are spaces 
to type in the beginning and ending points you want to play for this range.  

For the Magic Doors Launcher, I made a short animation that finished with 
the big keyhole view for each door.  That means on the 4 doors versions, 
there are four separate ranges to play, not counting the opening scene at 0 
seconds.  There is no set limit to the number of sub-animations you can set 
up using Play Range.  You simply set up a separate button to activate each 
one individually, preferably in the context of the story or lesson so that the 
action happens naturally as the result of a student's choice or action. 

The only disadvantage to using Play Range is that you need to do more 
planning ahead. I usually make notes as to what the beginning and end points 
of each range will be, and also think about what needs to be added to the 
page within each one. If you later realize you forgot to add something in the 
first range, it's a bit of trouble going in and deleting that item from all the 
later timepoints where you don't want it. 
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There is one more quirk: If you use the triangle on the IntelliMation timeline 
to check out your animation, it will pay no attention to any of the Play Range 
instructions, and you see a really crazy story as the entire thing plays.

3. Apparently 2 Or More Sounds In 1 Animation. Did you notice that for 
each door, you hear a sound effect as the keyhole expands or gets closer, 
followed by whatever preview sound you set up? The magic trick there is, 
button control rather than relying on automatic Page Actions.   Like the 
previous tip on using Play Range, you must first REMOVE default page action, 
Play Animation And Page Sound. In fact, you don't choose a Page Sound.   

Instead, you set up a way for the user to start the action, typically by 
clicking a button, perhaps as an answer response.  The button can have a list 
of actions, including playing one or more ranges of IntelliMation and 
activating one or more hidden buttons that play sounds.  For example, 
clicking the invisible buttons on the doors sets off the following set of 
actions:

As you can see, a single 
button activates another 
(hidden) button that plays a 
sound, next plays animation, 
at the end of the animation 
activates a second (hidden) 
sound button, pauses, and 
finally resets to 0 seconds. 

Notice that it doesn't matter where the hidden buttons are located, just so 
they are toolbar, not page, buttons. In this list, "keyhole sound" is on one 
toolbar, Hidden Stuff, while "Preview Sound 2" is on another, the one with 
the yellow buttons you used while setting up the launcher.  

Of course you can use this trick any time you need several sounds on a page, 
even if you are not using any animation.  Here's a twist: You could have a 
button pick randomly from a hidden toolbar of buttons, each of which plays a 
different sound.
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4. Stacking Regions And Buttons It's not obvious, but it's possible to have 
more than one thing happen when interacting with the same location on the 
page, by stacking a region and a button.   It works because a user activates a 
button by clicking it or scanning to and selecting it, while a region is 
activated by having something moved or dropped into it.  

Of course this is most convincing if you set the button's appearance to 
Transparent, so that it will be as invisible as the region. The experience of a 
student working an exercise using this trick is of interacting with real 
objects, in this case keyholes and a key.

You also can stack regions, and have each one accept a different item, so 
that different items placed in the area of the regions cause different things 
to happen.  Each region should be set up to accept one of the possible items, 
and to bounce things out immediately. To explore that possibility in detail, 
download the tip Vending Machine from Annie's Resource Attic.  In this 
example three stacked regions are used to detect and identify three 
different coins, and dispense the proper snack food depending on which coin 
is placed in the slot. 

5. Activate Buttons From A Region When the key is placed in the region 
surrounding one of the keyholes in the Magic Doors Launcher, a whole string 
of actions begin to happen. Yet a region can't have actions, so how is this 
possible?  

There is a very powerful option in 
regions that many people overlook: 
the ability to activate a button 
when the region accepts a correct 
item, and to activate another 
button if it rejects an incorrect 
item.  Of course you can choose 
actions for those buttons from 
the usual button actions list, and 
the buttons can be on a hidden 

toolbar.  That opens up a whole new world of ways to use regions!

©2016 ann brundige studio  www.annbrundigestudio.com
An IntelliTools Classroom Suite® lesson from Annie’s Resource Attic

Mar 15, 2016 12

http://www.annbrundigestudio.com
http://www.annbrundigestudio.com


To set up this option in a region, open its Properties and under the Design 
Properties tab, fill in the name(s) of one or both buttons to activate.  You 
don't have to use both slots. For example, in Magic Doors there was no 
incorrect answer, so I simply filled in the name of the button to activate 
after accepting an item. Then when the key is placed in one of the keyhole 
regions, a button is activated with the actions to play the door opening sound 
and to open the linked activity or other file.  

Caution: Fill in the names carefully!  The names have to match exactly, and 
they are case-sensitive.

How can you use this option in activities?  The simplest way is to activate a 
hidden button to give positive feedback for a correct answer when the 
region accepts an item, and to go to the next page.  Next, you could have a 
second hidden button activated when an item is rejected that says, "Try 
again!" You could go one step further by having the second button give a clue.  
Alternately, the second button might tell the student to read part of the 
activity again before having another try, and would then go to a previous 
page to let the student review.  Those are just right-wrong type ways to use 
this handy option.

As you see from Magic Doors, the region could activate a button to go 
somewhere, to another page or to another activity. Since the student has to 
put something into the region, this can be part of a story and require some 
kind of matching.  The reward is for something to open up--a door, a drawer, 
a treasure chest--which you can depict in going to another page or activity.  
The possibilities are endless, and I really like the way you can simulate real 
world experience here.

6. Open File attempts to open any kind of file. Make sure the application is 
available, or this fails. You could even have two Open File actions in the same 
button, and maybe open an exercise and an instructions PDF. 
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Open URL attempts to open a web page. You might use this action to set up a 
quick browser for students using switches. Clicking a button with that action 
will attempt to launch the default browser, and go directly to the URL page. 

Troubleshooting
I hope I have caught all the potential problems you might have with this 
template, and that you will enjoy using it to create a very special menu for 
your projects.  But just in case, here are solutions to all the difficulties I 
can imagine you might encounter. If you have a problem not covered here, 
contact me (abrundige@annbrundigestudio.com) and I'll be glad to help you!

1. Mea culpa. I forgot and used Insert Picture From File. My animation 
is a mess now! What do I do?  
Answer: I feel your pain! The easiest, least-time-lost fix is to trash the 
messed up template and start anew.  Be sure you have easy-to-access copies 
of any preview pictures and sounds before you ditch the messed up template. 

If you recorded a preview sound, export it, then trash the mess. You even 
can copy one preview picture onto the clipboard, ready to paste in when you 
have control-clicked the instructions inside the giant keyhole in the new 
copy of the template.  If you don't have to spend time re-making either 
preview pictures or sounds, it won't take long to fill in a fresh template.

2. The preview image displays too long, and kids start clicking randomly.  
Can I adjust the pause there?

Answer: Yes! The Pause action is in an invisible, transparent button around 
the keyhole. There's also a region there, so it is tricky to select with the 
cursor. Instead, select the button using the Edit menu.

First, make sure you are at 0 seconds. If you just opened your finished 
launcher, or you just saw a preview finish, pause (too long) and return to the 
doors, you are at 0. 

Under Edit, notice the words Properties... and Lock Position which are 
grayed, and under that hold down Select Object>  to open the drop-down 
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menu to its right. All the items on the page, many of them hidden, are listed 
in that drop-down. 

The button you want is labeled to correspond to its door: Preview 1 Button, 
Preview 2 Button, etc. where Preview 1 Button is the one on the keyhole of 
the first, leftmost door. When you select the button you want to change, 
the Edit menu closes, and you won't see anything different. Immediately, 
without clicking anything else, open the Edit menu again, and choose 
Properties, which is no longer grayed out. The Properties of your selected 
button will open. 

In Properties, under Actions, click the Edit button beside the Pause action, 
which initially I set to 2.5 seconds. Change that to fewer seconds, click OK 
to close Properties, and save your template with the change.

3. Can I change the words in the main caption without affecting the 
animation?

Answer: Yes! That text box, the ones above the doors, and the invisible 
buttons and regions were deleted at .5 seconds on the timeline, before 
making the remainder of the animation. Therefore, they are non-existent 
anywhere in the animation, and you can move them, change the text, change 
the backgrounds and text colors in the text boxes. Just don't cut and paste 
anything! That would echo all through the animation.

4. I have used a finished template for awhile, and it seems like the big 
keyhole opening is shifting. I now can see the edge of my preview 
picture on the bottom and right. Can I fix that?

Answer: Yes! But not easily. There is something in Classroom Suite that 
causes text boxes and pictures to shift a little, even if locked, when an 
activity is saved repeatedly.  The complication here is that the screen you 
need to work on is inside the animation, and the toolbars you used to create 
that preview screen are now hidden.  Also, the giant keyhole picture is 
locked and not responding to the mouse.  But here goes!
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Under the Edit menu, choose Custom Toolbars And Buttons...  You will see 
a green bar across the top of 
the screen, all the hidden 
toolbars probably appear as 
little gray squares, and a 
yellow Toolbar palette and a 
blue Button palette appear. 
Also, notice that the menus 
across the top of the page 
change. Now there is one 
called Toolbar.

Pull down Toolbar, and at the bottom of it there is a list of the custom 
toolbars in this template. Choose the first one, Add Preview Picture. 

Since this toolbar is hidden in the finished template, you see it as a small 
black square with a yellow outline to indicate that it is selected. On the 
yellow floating palette (Selected Toolbar palette)  uncheck the box beside 
Hide Toolbar, and the small square will expand so that you can see the 
purple buttons on the Add Preview Picture toolbar. Click Done in the upper 
right to close toolbar editing mode. 

Click the purple button that 
leads to the big keyhole image 
you have noticed shifting. The 
button names correspond to the 
doors, with Preview Image 1 
leading to the preview animation 
and picture attached to the 
leftmost door. Clicking the 
button will take you into the 
preview animation, to the 
timepoint where the keyhole 

image you need to move is located.
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While you are looking at the screen with the large keyhole, go to the top 
menu bar and pull down Edit->Select Object. To the right you see a list of 
all objects on the page. Choose Keyhole Frame. The name you see may have a 
number suffix, such as Keyhole Frame #2, depending on which door's 
animation you are editing.  Let the Edit menu close, and immediately open it 
again and choose Properties...

The Properties dialog of the Keyhole Frame will open.  This image is locked 
in place, and set to ignore the mouse. You'll need to reverse those settings 
to move it, so uncheck Locked and check Respond To Mouse Clicks.  Close 
Properties, and with the Keyhole Frame selected, use the keypad arrows to 
nudge the keyhole frame into its correct position, hiding your preview image.

Control-click the Keyhole Frame to open its Properties again. This time 
uncheck Respond To Mouse Clicks and put a check beside Locked.  Save 
your launcher again. Hopefully, the changes will last a long time!  
Unfortunately, I don't know any way to prevent objects from shifting over 
time.

Credits

Artwork in the Magic Doors Launcher is original by Ann Brundige and was 
created in the 3D CAD application Vue using photo textures downloaded 
from textures.com.  The doors you see in the backgrounds are from all over 
the world, and none of them were originally in the walls in the finished 
backgrounds. Blank stage sets with two, three, and four doors were created 
in Vue and textured with portions of the photos, then extensively edited in 
PhotoShop® to make several background choices for each template that can 
be used interchangeably.

This activity was downloaded from Annie's Resource Attic and is copyright 2016 by ann 
brundige studio. You may make and distribute as many copies as you want, but must include 
this attribution information. You may not sell this activity, nor use any of its elements for 
commercial purposes. For details regarding this Creative Commons license, see the Terms of 
Use section of the web page at www.annbrundige studio.com .
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